Entropy Based Transition Analysis of Eye Movement on Physics Representational Competence

Seyyed Saleh Mozaffari Chanijani
University of Kaiserslautern
German Research Center for Artificial Intelligence
Kaiserslautern, Germany
mozafari@dfki.uni-kl.de

Jochen Kuhn
University of Kaiserslautern
Faculty of Physics
Kaiserslautern, Germany
kuhn@physik.uni-kl.de

Pascal Klein
University of Kaiserslautern
Faculty of Physics
Kaiserslautern, Germany
pklein@physik.uni-kl.de

Andreas Dengel
University of Kaiserslautern
German Research Center for Artificial Intelligence
Kaiserslautern, Germany
dengel@dfki.uni-kl.de

Syed Saqib Bukhari
German Research Center for Artificial Intelligence
Kaiserslautern, Germany
saqib.bukhari@dfki.de

Abstract
In this paper, we have conducted an eye tracking experiment by employing an inexpensive, lightweight, and portable eye tracker paired with a tablet. Students were instructed to solve the physics problems by presenting them three coherent representations about a phenomenon: Vectorial representations, data tables and diagrams. The effectiveness of each representation was assessed for three levels of student expertise (experts, intermediates and novices) using entropy-based transition analysis of the gaze data. The results show that students of different skill level (a) prefer different representations for problem-solving, (b) switch between representations with different frequencies, and (c) can be distinguished by the density of representation use. The obtained results confirm earlier findings of physics education research quantitatively which were initially obtained by student interviews and observational studies.

Author Keywords
mobile eye tracker; physics; Representational Competence; education; entropy, transition;

ACM Classification Keywords
K.3.0 [COMPUTERS AND EDUCATION]
Introduction

Students’ competence in using different representational formats and transfer one in another; so-called representational competence, is a popular topic in current science education. Recent research projects in mathematics and physics education paid a lot of attention to study students’ competence with different representational formats [10]. It has been shown that a competent handling of Multiple Representations (MR) is linked with domain expertise and serves as a basis for gaining deep, robust and flexible conceptual understanding of the underlying physics domain [11] [12]. Competent handling of MRs includes the interpretation of single representations, switching between representations, and making choices among representations. The insight about this competence is interesting for instructors to increase the quality of education. In addition, authors and publishers could gain insight from this information to publish adaptive physics books appropriate for different level of student expertise and for variety type of problems.

Many works have been already done in Physics Education Research on students’ representational skills including [3] [5] [4] [6] [7]. These studies ask what students know about representations, and how that knowledge might affect students’ performance [12]. However, there are only a few studies which compare students’ attention to representation while solving the problem. Some studies highlighted differences between problem-solving approaches of experts and novices, with some of these differences involving representation use [13]. It has been argued that different isomorphic representations of a common formal structure can cause dramatically different cognitive behaviours (so-called accidentRepresentational Effect [15]). With respect to this, eye tracking as a method may provide useful insights into the student competence with different representational formats [14] as it may reveal whether correct solutions can be triggered by particular details of the representation and dependent on the type of the problem.

In this paper, we employ a mobile remote system for our study in an educational environment. Inline towards the goals of our previous works [11][2], in order to use mobile, flexible and inexpensive eye tracking systems, we employed a mobile remote system in our study in an educational environment. Such systems are suitable for eye movement researches in the real-world scenarios.

The line of research in which the current study fits focuses on the relationship between student success and the representational format they chose when they are confronted with a multitude of representations. Beyond the theoretical contribution of this research to the fields of representations and cognition, it has practical implications for designing instructional representations that support the development of conceptual understanding. In order to achieve this goal, we are trying to answer the following two questions in this paper: Do experts use different representations to solve a problem compared to novices? Do experts use more compressed representations compared to novices?

Methodology

This section briefly explains the entropy based transition analysis of eye movements between different representations (table, vector, and diagram) during physics problem solving with the help of representations that have already been discussed in the previous section. Entropy is a measure in information theory to describe the information in a variable in terms of ordering. This measure is called Shannon entropy and it is defined as:

$$H(R) = - \sum p(r_i) \log_2(r_i), r_i > 0$$

where $H(R)$ is the entropy in bits and $p(r_i)$ is the proportion of measurement $r_i$. 
The experiment was constructed with two sets of questions. Each set contains 5 questions with corresponding answer sheets. This figure shows the first question of the first set.

Transition Matrix Entropy
Entropy can be calculated for a transition matrix[8]. The lowest possible value is zero (0) when there is no uncertainty about what type of transition will occur. The maximum value for entropy is when all the cells in the transition matrix carry different values. For example, for a transition matrix with six cells, the maximum value would be $-6 \frac{1}{2} \log_2 \left( \frac{1}{6} \right)$, which equals to 2.59 bits. Bits is not an intuitive unit, however, by dividing $H(R)$ by the maximum value of the entropy (2.59 in our case) we gain the normalized entropy that allows to make comparisons of results across groups and stimuli[8].

Scan Path Entropy
In order to calculate scan path entropy, the AOI (Area of Interest) string must be generated. According to [9] we followed these steps:

1. Choose a target AOI. Text, table, vector and diagram.
2. Transform each scan path into a character string. Each character refers to a fixation in a specific AOI.
3. Remove all repetitions. "AAABCDDT" becomes "ABCDT". In fact, this is going from a fixation-based representation to a dwell based representation [8]. A dwell consists of one or more fixation within one AOI.
4. Remove repetitions of two characters ("ABABCDT" becomes "ABCDT"). This is removing re-fixations from a pre-planned path. Re-fixations may occur if the previous fixation was too short to allow for visual analysis and occur during search, reading and free viewing. These re-fixations have been removed because they originate from timing errors in oculomotor control, not from choosing an ineffective path.
5. Count the number of unique scan paths.
6. Construct a histogram of the unique scan paths and their frequency.
7. Apply the entropy formula to compute entropy.

Experiment Setup
In this section, we explain the eye tracking system that has been used in this study and the procedure applied to conduct the experiment for this study.
Remote Mobile Eye Tracking systems

The emergence of lightweight and portable eye trackers paved a new path for the researcher to acquire and analyze data in real-world environments such as psychotherapists' clinics, hospitals and classrooms. With respect to the importance of mobility and flexibility, we preferred the SensoMotoric Instrument iView X REDn scientific eye tracker operating at 60Hz in order to carry out our study. The tracking error reported by the manufacturer was less than 0.4 degree, which makes it appropriate for fixation based eye movement studies. The eye tracker was paired with Microsoft Surface PRO recommended by the eye tracker manufacturer. Post processing was conducted by the custom software written in Python. Figure 1 shows our experimental setup.

Procedure

The instructional material were physical problems (Problem 1: trajectory / air resistance; Problem 2: the arbitrary motion of a sphere), for which ten questions had to be answered as either true or false. In order to solve the problem and answer the questions correctly, three isomorphic representations were displayed. The three representations are equal within each problem and capture the information to solve the question. The representations appeared always on the same place on the screen. Before starting the experiment the student's familiarity is assessed with each kind of representation was assessed using 13 Likert-type items (Cronbach’s alpha = .94). Moreover, students had to judge their experience with motion processes. Both information were combined to define expertise levels.

The experiment is designed in two eye tracking phases corresponding to the two selected problem sets. The processing of the phases is equivalent. First, participants are asked to sit 60 cm away from the tablet to perform 9-point calibration and validation of the eye tracker. Each problem contains five questions. The first question with three representations namely table, vector and diagram, is shown in Figure 2. In this step, the eye tracking server starts to record the gaze. Only after the participants finished reading the question, the answering page loads in order to answer the question while the user’s gaze is recording. This process is repeated for all question. Eye gaze information for each question page and the answering page was saved separately for further analysis. Figure 2 shows the first question of the first set of problems on the top while the bottom indicates the corresponding answering page. The flowchart of the experimental process is shown in Figure 3.

![Figure 3: The procedure of the experiment.](image)
Results
Table 1 summarizes the statistics of four measures for users of different expertise levels. Our evaluation is fourfold: Firstly, we calculated the accumulative heat maps of each expertise group and found the difference between novices and experts. Figure 4 shows appropriate heat maps for novices, intermediates and experts respectively. For novices, the heat map indicates that they had most of their fixations on the question itself. In contrast, expert's gaze is concentrating on the representations. It indicates they have less struggling with the comprehension of the questions compared to intermediates and novices.

We found out the vector representation was used at least among all expertise levels. Secondly, we analyzed the gaze data with respect to shifting the focus among representations in a given problem. If a participant spent more than 80% of the time on one single representation 'A', we assume that he did not consider any other representation than 'A' to solve the question. In about 9 of 10 times, novices switched between at least two representations before giving an answer, whereas experts did so only in about 75% of the setup. Thirdly, we have calculated the ratio of representation gaze to (text gaze + representation gaze) for every expertise level. We refer to this as the density of representation use. As a fourth finding, we evaluated the confidence score, which reflect that experts are both more efficient and more confident than novices, i.e. the confidence scores differentiate between the expertise levels.

As it turned out that the problems were quite simple (overall solution probability was 0.9), we analyzed the hardest question of our setting in more details. The evaluation shows that it was solved correctly only by 11 out of 15 users (73%) responding with a confidence score of 76%. To answer this question, there were five students who used only one single representation and they all answered it correctly (three used only the diagram, and two used only the data table). The representation they have used in this particular question was also their favorite representation in most cases and the representation they felt most familiar with according to their familiarity estimate. Table 2 shows Step-by-step entropy calculations for the transition matrices of the three classes of expertise. The entropy of transition for experts, intermediates and novices are 1.950, 1.997, 2061 bits with normalized entropy of 0.7528, 0.771, 0.7958 respectively.

Figure 5 shows scan path entropy of experts, intermediates
Table 1: Statistics of four measures for different expertise levels. N is the number of participants in the corresponding categories Experts, Intermediates and Novices. P represents the score out of 10. The number in the parentheses are standard error of the estimate.

<table>
<thead>
<tr>
<th>Expertise Level</th>
<th>N</th>
<th>P</th>
<th>Representation Used</th>
<th>Density</th>
<th>Confidence Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expert</td>
<td>7</td>
<td>10</td>
<td>17.90% 40.8% 41.4%</td>
<td>24%(5.3%)</td>
<td>95%(3%)</td>
</tr>
<tr>
<td>Intermediate</td>
<td>5</td>
<td>9.5</td>
<td>23% 38% 39%</td>
<td>20%(8.3%)</td>
<td>88%(4%)</td>
</tr>
<tr>
<td>Novice</td>
<td>3</td>
<td>7</td>
<td>22.8% 50.9% 26.3%</td>
<td>10%(5.8%)</td>
<td>84%(6%)</td>
</tr>
</tbody>
</table>

and novices. Novices tend to switch much more between representations, hence their entropy is larger. This is confirmed by the data: The more expertise, the less switching occurs.

**Discussion**

There is a tension between designing representations best suitable to foster learning and understanding, on the one hand, and the careful analysis of the complex cognitive mechanisms of their use and interpretation accounting for student's diversity of conceptual resources, on the other hand. The present contribution here is preliminary, but yet suggests some crucial differences between expert and novice problem solvers.

We were surprised to find that novices were just as likely to use multiple representations as experts and that they moved more often between them. By doing so, they may be hoped to strike a hint leading to a correct approach. Experts, in contrast, proceeded more systematically and stuck to one single representation. Their representation use is more compressed. Especially when they were confronted with a hard question, they focused on the representation they are most familiar with and solved it correctly. Experts are more confident in their response reflecting some metacognitive awareness respecting their problem-solving strategy. They tend not only to use the representation more purposeful than novices but also know why they do so. Concerning specific representations, we found that novices used the diagram significantly less often than experts and preferred the numerical representation (table). It is obvious that diagrams are more difficult to be interpreted correctly compared to numerical values and that an appropriate understanding of kinematic graphs is a key to succeeding in scientific problem-solving. Avoiding diagrams and restricting oneself to numerical representations reflects a behavior of novices that have been experienced in other studies. Our gaze data support these findings quantitatively.

For the scan path entropy results from an educational perspective, this makes sense because novices hunt for information, they browse through the representation aimlessly. In contrast, experts know where to look and hence their entropy is smaller.

**Conclusion**

In this paper, the study of representational competence in physics education research with a tablet eye tracking system has been presented. Due to the environment of the research, this type of eye tracking systems is much more appropriate. For three levels of student expertise: experts, intermediates and novices the effectiveness of each representation was studied. The results confirm that students prefer different representations depending on their skill level leading to direct implications for physics education. The novices struggle with representations more than experts to
Table 2: Step-by-step entropy calculations for the transition matrices of experts, intermediates and novices

<table>
<thead>
<tr>
<th>Transition</th>
<th>Novices</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>Intermediates</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th>Experts</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>$p(r_i)$</td>
<td>$\log_2 p(r_i)$</td>
<td>$p(r_i)\log_2 p(r_i)$</td>
<td>$p(r_i)$</td>
<td>$\log_2 p(r_i)$</td>
<td>$p(r_i)\log_2 p(r_i)$</td>
<td>$p(r_i)$</td>
<td>$\log_2 p(r_i)$</td>
<td>$p(r_i)\log_2 p(r_i)$</td>
<td>$p(r_i)$</td>
<td>$\log_2 p(r_i)$</td>
<td>$p(r_i)\log_2 p(r_i)$</td>
<td>$p(r_i)$</td>
<td>$\log_2 p(r_i)$</td>
<td>$p(r_i)\log_2 p(r_i)$</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vector → Table</td>
<td>0.3</td>
<td>-1.736</td>
<td>-0.521</td>
<td>0.37</td>
<td>-1.434</td>
<td>-0.531</td>
<td>0.44</td>
<td>-1.84</td>
<td>-0.521</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Vector → Diagram</td>
<td>0.59</td>
<td>-0.761</td>
<td>-0.449</td>
<td>0.49</td>
<td>-1.029</td>
<td>-0.504</td>
<td>0.62</td>
<td>-0.689</td>
<td>-0.427</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagram → Table</td>
<td>0.95</td>
<td>-0.074</td>
<td>-0.070</td>
<td>0.93</td>
<td>-0.105</td>
<td>-0.097</td>
<td>0.9</td>
<td>-0.152</td>
<td>-0.137</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagram → Vector</td>
<td>0.89</td>
<td>-0.168</td>
<td>-0.149</td>
<td>0.83</td>
<td>-0.269</td>
<td>-0.223</td>
<td>0.66</td>
<td>-0.599</td>
<td>-0.396</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table → Diagram</td>
<td>0.81</td>
<td>-0.304</td>
<td>-0.246</td>
<td>0.87</td>
<td>-0.201</td>
<td>-0.174</td>
<td>0.78</td>
<td>-0.358</td>
<td>-0.279</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Table → Vector</td>
<td>0.46</td>
<td>-1.12</td>
<td>-0.515</td>
<td>0.56</td>
<td>-0.837</td>
<td>-0.468</td>
<td>0.76</td>
<td>-0.396</td>
<td>-0.301</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Hunt the information. In future work, we have to consider the purpose behind the use of the available representations with more details.

Acknowledgements
This work was funded by the Federal Ministry of Education and Research (BMBF) for the project AICASys.

REFERENCES


Cognitive Science, Volume 18, Issue 1, pages 87, 122.